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Chapter 8:  Understanding and Using Attribute Data, Queries, and 
Analysis 

In this Exercise: 

 

 Attributes and Metadata 

 Viewing Attributes and Selecting Features 

 Spatial Queries: Identifying and Selecting Features on the Map 

 Selecting Features using Find 

 Buffer Analysis 

 Selecting Features using Attribute Queries 

 

Attributes and Metadata 

 

In Chapter 3, we defined metadata as information about data layers and viewed an 

example file in HTML format.  Understanding and using geographic data depends on the 

availability and quality of Metadata especially when considering Attributes. For example, 

open the attribute table for the CONSPUB layer and you will notice many attributes with 

cryptic names like "MACODE", PPTYPE", and "SPTYPE1." The values for some of the 

attributes are codes, which are meaningless unless we now what they represent. The 

metadata can help us understand these attributes. 

 

In a metadata file, appearing in HTML format, the section Entity and Attribute 

Information can be selected to learn more about attributes for particular data layers. 

 

 

 
 

a) Open the file CADASTRALPUBLANDS_CONSPUB.htm (located in the 

c:\INTROGIS\METADATA\ folder) in a web browser. 

 

b) Read the abstract for this data layer by scrolling down under the Identification 

Information section. 
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c) Check the Data Quality Information section for an update history. 

 

d) Click on the Entity and Attribute Information link to find out what the 

attributes named above mean, and what the codes used in PPTYPE mean. 

 

Not all metadata is formatted to meet a Federal Geospatial Metadata standard! Open the PDF 

called !RECORD LAYOUT for IND TOWN FILES in your METADATA folder to learn more 

about the grand list data we joined to the Brunswick Parcel data in chapter 6. Although this file 

does not actually identify the names of the different attributes, it provides enough description and 

listing of codes for us to understand our joined data better: 

 

 

 

Viewing Attributes and Selecting Features 

 

Data associated with spatial features in the geographic data files is commonly referred to 

as Attribute Data or simply Attributes.  Attributes are stored as tabular data for spatial 

features. 

 

1. Viewing Attributes 

 

a) Open QGIS  

 

b) Open the Project Properties Window by clicking on "Project" in the tool bar 

and choosing "Project Properties." 

 

c) Click to put an X in the “Enable On The Fly CRS Transformation” box  
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d) Type 32145 in the Filter box. You should see the Vermont Coordinate system 

listed above the search box. Make sure it is highlighted (or click on it to 

highlight it). 

 

e) and then Click on the  button 

 
 

f) Add the Brunswick_parcel data layer that you just created to the project. 

 

g) Right click on Brunswick_parcel in the Table of Contents and select 

"Open attribute table" from the list. 
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The new window displays: 

  
e) Move this window on the screen so you can view both the Attributes 

and the QGIS interface. 

 

Each Row is an individual record for each spatial feature, in this case a 

polygon defining a boundary.  Scrolling down the list you will see that 

there are 180 polygons, or features, in this Shapefile. Each feature in 

the Brunswick_parcel shapefile represents a landed property. 

 

 

f) Scroll across the table to view the Columns or Fields of Attribute Data 

that contain data for each record. 

 

f) To view the list of parcels in order from lowest acreage to highest, click 

on the column heading (the word Acres) in the farthest right column.  If 

you click again it will switch the order to start with highest. These 

actions do NOT change the data itself in any way. 
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2. Selecting & Exporting Attributes  

 

In is often useful to export records either individually or some portion of 

the entire table for use in other applications.  For example, it may be 

useful to export the records for all properties owned by the town of 

Brunswick. 

 

With brunswic_5 values sorted in ascending order: 

 

a) Look for the properties with BRUNSWICK, TOWN OF listed in the 

brunswic_5 attribute column.  

 

b) Click the number all the way to the left of the first row.  

 

c) Use the scroll bar if needed to move to the bottom of the list of Town 

properties. 

 

d) Hold down the shift key and left-click on the number all the way to the 

left of the last row. 

 

 
 

All 255 records should be selected and highlighted in blue. 
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e) click on the button at the top of the table that says "Copy selected rows 

to clipboard" when you hover over it. 

 
 

 

 

f) Open a program such as Excel and you can paste the values into a 

spreadsheet.   

 

 

3. Selecting Attributes and the Map View 

 

a) Click on the icon that looks like a magnifying glass at the top of the 

attribute table. This Zoom Map to the Selected Rows tool should allow 

you to see the 4 very small properties owned by the town of 

Brunswick. They show up as yellow-highlighted parcels on the map.  

 

 

b) Try clicking on other rows in the Attribute table to see that the 

corresponding property is highlighted on the map.  
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c) To clear, or unselect, features use the "Deselect features from all 

layers" button in the map toolbar (same button is available in the 

Attribute window). 

  

 
 

This exercise demonstrated the interaction and connectivity between the 

Attributes and their spatial features. Each record in the Attribute table is a 

spatial feature, therefore selecting records in the Attribute table has 

changed the map to show these selections visually. 

 

 

Spatial Queries: Identifying and Selecting Features on the Map 

 

Tools available in the toolbar allow the user to identify and select features directly 

on the map.  Inquiries such as these are referred to as Spatial Queries. 

 

1. The Identify Tool   

 

The Identify Tool is a quick way to identify features on the map without 

selecting, or highlighting, spatial features or attributes.  Features do not appear 

yellow and are not highlighted in the Attribute Table when using the Identify 

Tool. 

 

a) Open the project file ch8exercise.qgs (QGIS will ask you if you want 

to save the current project  - choose “discard”. This will close the 

previous project and open ch8exercise.qgs) 

 

b) Make sure that WATER_WBD8VT_POLY, is the active layer in the 

Table of Contents and is therefore highlighted in blue (left click on it if 

it is not). 

 

c) From the toolbar click on the Identify Tool and place the cursor over 

the map.  You will notice that the cursor has a lower case "i" next the 

arrow now. 
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. 

 

The default display in the Map View shows towns and subbasins, or 

watersheds, in Vermont based on USGS hydrologic unit boundaries 

(HUC8 level).   

 

d) Use the Identify Tool by clicking in a subbasin on the map.  This will 

open the Identify Results window and highlight the feature chosen in 

red. 

 
 

 

The Identify Results window displays the Fields found in the Attribute 

Data, and Field Values (you may need to scroll to the right in the 

Identify Results window to see the values) for the Identified Feature. 

At the top of the window, the data layer is identified. 

 

d) Use the Identify Tool to identify and display Identify Results for other 

subbasins. 

 

e) Make BOUNDARY_TWNBNDS_POLY the active layer in the Table 

of Contents and use the Identify Tool to identify Towns. 

 

f) Set the scale at 1:400,000. Notice that more data layers are now visible 

on the map (they were set to render only at scales greater than 

1:400,000) 
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g) Use the Identify Tool to click and identify FISHING access sites  

(TOURISM_FISHING_POINT). 

 

h) Use the Identify Tool to click and identify major roads 

(TRANS_RDSMAJ1_LINE).   

 

i) Use the Identify Tool to click and identify Public Conserved Lands 

(CADASTRAL_CONSPUB_POLY). 

 

 

 

2. The Select Features Tool 

 

With the Select Features tool, spatial features are selected directly from the 

active layer on the map by clicking on them or drawing a shape that 

encompasses them. Features are then highlighted on the map and in the 

Attribute Table. 

 

a) Click on the layer TOURISM_FISHING_POINT in the Table of 

Contents to make this the active layer. 

 

b) Click the small down arrow to the right of the Select Features Tool on  

the toolbar. Note that you can choose from among a number of 

different selection options. Try “select single feature” first 
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c) Zoom in anywhere on the map at the scale of 1:400,000 or larger (i.e. 

zooming in closer, for example 1:200,000, is a larger scale). 

 

d) Click on any of the small black circles that represent Fishing Access 

Sites and notice that they are highlighted yellow. In order to select 

more than one feature, you must hold down the CTRL key. 

 

e) To view attributes for the selected points from the layer 

TOURISM_FISHING_POINT, click on the Open Attribute Table 

button in the toolbar.   

 

 
 

 

The attributes table will open and the number of features selected will 

be noted at the top of the window. In order to see the attributes of the 

selected features, click on the "Move selection to top" button and the 

attributes of all of the highlighted features will be moved to the top of 

the table. 

 

 
 

Close the attribute table when you are done exploring. 

 

h) Use the "Deselect features from all layers" button to clear selected 

features before moving on to the next section.  
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Selecting Features Using an Expression in the Attribute Table 

 

We can search for features based on their attributes within the Attribute table. 

 

a) Add the Brunswick_parcel shapefile to the project 

 

b) In the Table of Contents, click on the Brunswick_parcel to highlight it. 

 

c) Right click the layer name to open its Attribute table. 

 

d) At the top of the table, click on the “select features with an expression” 

icon.  

 

e) Click on the plus sign next to Fields and Values 

 

f) Scroll down until you see brunswic_5, double click on  it 

 

g) Single Click on the equals sign 

 

h) Type ‘VT ELECTRIC TRANSMISSION INC’ to the right of the equals 

sign, making sure to use single quotes and all capital letters.  
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i) Click on the Select button below the expression you have created. 

 

j)  Close the Select by Expression dialog box. 

 

k) Click on the Zoom to Selection button. What did we select? 

 

l)  Leave this parcel selected to follow instructions in the next section. Close 

the attribute table. 

 

Buffer Analysis 

 

Setting a distance and drawing an area around selected features is the process by 

which buffers are created.  Buffers can also select new features from a different 

layer that fall within the specified distance. 

 

For example, we can create a buffer around the parcel selected in the previous 

section in order to identify abutting properties. 

 

a. Open the Buffers Window from the Vector menu:  

Vector> Geoprocessing Tools > Buffers 

 

 

 

 

 

b. In the Buffer window make the following selections: 

i. Make sure Brunswick_parcel is the chosen data layer 

ii. Buffer distance should be set to 10 (meters, by default) 
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iii. Click on "browse" to designate a location for the shapefile that will 

be created (navigate to where our other DATA is stored). 

iv. Add an X  to the box “Use only selected features” 

 

v. Leave other items the same. 

 

 
 

c. Click  to close the Buffer window, and then click on Yes to 

allow the Shapefile to be added to the project. 

 

i. The map view should now display a shapefile over the selected 

parcel that reflects a 10 meter buffer beyond the edge of the parcel. 
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d. We can use the buffer shapefile to select other features in this layer (or 

other layers).  

 

e. In the Vector menu, choose "Research tools" and then "Select by location" 

 

 

f. Set "Select features in" to Brunswick_parcel.  

 

g. Set "That intersect features in" to buffer (or whatever you named your 

buffer shapefile). 

 

h. Click on "OK"  then close the window. 

 

i. Open the attribute table for the Brunswick_parcel layer.  

 

j. Click on the "Move selection to top" button and you should see 7 features 

highlighted at the top of the table. These parcels were selected because 

they fell within the 10 meter buffer you created around the electric 

transmission line corridor. This is one way of identifying abutters.  

 

 

k. If you wanted to send letters to all abutters, you would now copy and paste 

these records into a spreadsheet and use that to create form letters or to 

address envelopes! 
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Selecting Features Using Attribute Queries 

 

Building a complex Query expression is a powerful and precise method to select 

features using attributes. 

 

Query Builder 

 

a) Zoom to the Full Extent  

 

b) In the Table of Contents make WATER_LKCH100_POLY (Lake 

Champlain boundary) the active layer. 

 

c) Click on the layer menu and choose "Filter" 
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d) In the Query Builder window use the following steps to build a query 

expression that will select islands in Lake Champlain that are between 

5,000 and 6,000 acres (20,235,000 sq. meters and 24,282,000 sq meters) in 

area. 

Watch the Query expression as it is built. 

Selections include Fields, Operators, Values and text as follows: 

 

i. Double click "ISLAND" in Fields  

ii. Single click "=" in Operators  

iii. Single click on the "All" button below Values 

iv. Double click "Y" in Values 

v. Single click "and" in Operators 

vi. Double click "area" in Fields 

vii. Single click ">" in Operators 

viii. Single click just to the right of the ">" in the "provider 

specific filter expression" box and type 20235000 

ix. single click "and " in Operators 

x. Double click "area" in Fields 

xi. Single click "<" in Operators 

xii. Single click just to the right of the "<" in the "SQL where 

clause" box and type 24282000 
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Click the "Test" button to see if your query will work (if not, 

check your choices, spelling, quotation marks, etc.) and then click 

the "OK" button. 

 

Note: It is possible to type the query expression directly into the 

text box as it appears below: 

 

( ISLAND  =  'Y'  and  area  > 20235000 and  area  < 24282000 ) 

 

 

e) After you click "OK" open the attribute table for 

WATER_LKCH100_POLY and notice that there seems to be only one 

feature. Zoom to that feature  

 

f) Change the Active Layer to Town Boundaries by clicking on that layer. 

 

 

g) Use the Identify tool to find out the name of the town/island  

 

 
 

 

 


